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Introduction

The purpose of this Course Handbook is to provide you with general information about
studying with the Institute of Commercial Management (ICM). This Handbook should be read
in conjunction with other Guidelines available on the ICM website. The early pages of this
Handbook provide general information about ICM and its programmes. Later sections give
details about the equivalency of ICM Certificate (NQF* Level 4 qualifications), Diploma (NQF
Level 5 qualifications), Advanced Diploma (NQF Level 6 qualifications), Graduate Diploma
(NQF Level 6 qualifications) and Post Graduate Diploma Awards (NQF Level 7
qualifications). Please note that not all Levels are available for all programmes. The material
in this Handbook is as accurate as possible at the time of production.
*NQF: the UK National Qualifications Framework
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The Institute of Commercial Management (ICM)

Established in the early 1970s, the Institute of Commercial Management provides academic
and vocational qualifications which are well recognised globally.
In its capacity as a course developer and an examining and certifying Board, the Institute
offers a wide range of professional and vocational awards in Business, Management and
related vocational areas.
ICM programmes are designed to address the personal development and training needs of
those wishing to enter the commercial sector and to support the continued development and
workplace flexibility of those already in employment.
ICM’s global services include the design, development and certification of business
education and training programmes for education providers; the development and
certification of tailored education and training programmes for the corporate sector,
emerging industries and the global workforce and the examination, assessment and
certification of students undertaking business, management and related vocational education
programmes.
An acknowledged specialist in the design and development of progressive, practical and
multi-functional programmes of study, the Institute works with a range of public and private
sector clients including universities, business schools, colleges, training providers,
International Development Agencies, government agencies and local authorities.
ICM provides examinations in more than 200 subject areas ranging from accounting and
finance to tourism and hospitality and from marketing and advertising to project management
and examines and certifies candidates to an internationally consistent standard.
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ICM Articulation Agreements with Universities

The Institute has formal partnership arrangements with universities in the UK and overseas.
A full list of progression routes from ICM qualifications into Undergraduate and Post
Graduate courses at UK Universities is available from the ICM website.
Established articulation arrangements provide direct access to the second and final years of
a wide range of BA/BSc degrees for ICM Diploma qualifications (Level 5 Diploma) and
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Advanced Diploma qualifications (Level 6 Diploma). Access to Masters programmes also
exist for those with ICM Graduate Diplomas (Level 6) and ICM Post Graduate Diplomas
(Level 7). In addition, ICM Certificate (Level 4 Diploma) holders may be eligible for entry to
year 1 of appropriate degrees.
Subject to status and grades obtained, students holding ICM Diploma qualifications at levels
4, 5, 6 and 7 are accepted onto Undergraduate and Post Graduate degree programmes
offered by institutions in continents across the globe.
Our strategic partners have agreed that students can enter their degree programmes with
Advanced Standing, provided they possess the right Grade profile and are able to meet
other admissions criteria, such as language competence. The stated grade and points
requirements may be subject to local variations.
Entry to the First Year
Application for entry to the first year of a relevant degree programme will be considered for
those students who hold a relevant ICM Certificate Level Award.
Entry to the Second Year
Application for entry to the second year of an Honours degree programme will be considered
for students who have passed a relevant ICM Diploma (Level 5) programme and have met
the following requirements:
 obtained at least 24 Points from 8 subjects leading to the qualification
 obtained at least a Grade C in all subjects in the Diploma
Entry to the Final Year
Students who have passed a relevant ICM Advanced Diploma (Level 6 Diploma) programme
will be considered for final year entry if they have achieved the following:
 obtained at least 32 Points from 12 subjects leading to the Advanced Diploma
 obtained at least a Grade C in all subjects in the Advanced Diploma
Entry to the Post Graduate Year
Students who have passed a relevant ICM Graduate Diploma (Level 6 Diploma) programme
will be considered for entry to Masters programmes if they have achieved the following:
 obtained at least 12 Points from the final 4 subjects leading to the qualification
 obtained at least a Grade C in all subjects in the Graduate Diploma

Converting ICM subject grades into points
The following rules apply in relation to converting ICM subject grades into points:





an ‘A’ grade is awarded 6 points
a ‘B’ grade is awarded 4 points
a ‘C’ grade is awarded 2 points
a ‘D’ grade is awarded 0 points
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Progression Routes
Students wishing to progress to degree programmes should review the range of courses
available at our partner Universities. Information on appropriate university courses can be
obtained from our website.
The Institute’s qualifications are also recognised by leading professional examining bodies
for either subject exemption or registration purposes. Further details can be obtained from
the appropriate examination bodies.
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Learning, Teaching and Assessment Strategy

Tuition in preparation for the Institute’s examinations takes place on a number of levels,
including lectures, seminars, class discussion and problem review and analysis.
Formal lectures provide a foundation of information, which students build on through directed
learning and self-managed study outside the classroom.
Students are actively encouraged to form study groups to discuss course material, fostering
a greater depth of learning experience.
4.1 Assessment
Assessment for the majority of programmes is based on final examinations. The Institute has
a traditional approach to assessment. Formative assessment is provided by ICM Teaching
Centres as and when appropriate and may include; essays, in-class tests, role play
exercises, presentations and projects. However, in terms of gaining a professional
qualification, and in order to maintain standards, ICM believes that students should be
formally assessed on the body of knowledge covered during the course and be examined as
individuals on the required learning outcomes.
4.2 Student Workload
In accordance with nationally accepted codes of practice in the UK, each 20 credit unit
represents a total of approximately 200 hours of learning. Typically, each ICM award at
undergraduate level comprises four units of 20 credits each. Students must complete four
units at each level leading to the awards of Certificate (Level 4 Diploma), Diploma (Level 5
Diploma), Advanced Diploma (Level 6 Diploma) and Graduate Diploma (Level 6 Diploma).
Thus, for example, in order to gain an ICM Advanced Diploma, a student must have
completed the Certificate, Diploma and Advanced Diploma stages. The Post Graduate
Diploma (Level 7 Diploma) consists of 120 credits divided into six units.
The learning hours for each unit are subdivided into appropriate categories of learning
opportunities, such as lectures, seminars, preparation time, directed study, time spent on
assessment items and exam preparation. At least one quarter of this time is usually devoted
to formal contact time.
A further one quarter of this time is related to directed learning. The balance of workload is
comprised of individual, self-managed student learning and revision.

International Trade

3

Note that for a unit delivered in standard mode, the ICM examinations calendar
accommodates a teaching year of approximately 2 x 20 teaching weeks, and four weeks of
revision/end of year assessment.
Furthermore, each unit is assigned to a particular ‘Level’, with each Level corresponding to
the group of subjects contained within the programmes leading to the award of a Certificate
(Level 4 Diploma), Diploma (Level 5 Diploma), Advanced Diploma (Level 6 Diploma),
Graduate Diploma (Level 6 Diploma) or Post Graduate Diploma (Level 7 Diploma).
5

ICM Qualifications and Progression

Understanding your qualification is important and the following guidelines outline how ICM
qualifications fit within the UK National Qualifications Framework and support vocational
learning.
ICM has benchmarked its qualifications against the UK National Qualifications Framework
(NQF). In recognition of the NQF levels and with reference to appropriate National
Occupational Standards, the Institute has produced the following level descriptors which
should be read in conjunction with the table provided in section 5.6.
5.1 ICM Certificates (equivalent to NQF Level 4 Diplomas)
ICM Certificates are awarded to those who have passed Part 1 (the first four or five subjects,
depending on the course) of an ICM Diploma programme. See below for ICM Diploma Entry
Requirements. ICM Certificates represent a level of qualification that recognises the ability to
gain, and where relevant apply a range of knowledge, skills and understanding.
ICM Certificate holders should be able to display competence in the application of
knowledge in the performance of a range of work activities, some of which may be routine
and predictable with some being complex or non-routine.
Learning at this level involves gaining knowledge and skills appropriate for individuals
working semi-independently, or receiving basic supervision and training from others in their
field of work.
Students should begin to develop a degree of individual responsibility or autonomy in their
study as well as the ability to collaborate with others, for example through participation in
work groups or teams.
Successful completion of the ICM Certificate enables entry to the first year of appropriate
degree programmes at a range of Universities. For a complete list of progression routes
please refer to the website.
5.2 ICM Diplomas (equivalent to NQF Level 5 Diplomas)
Entry to an ICM Diploma programme requires completion of secondary education or an
equivalent and recognised programme of study.
ICM Diplomas represent a level of qualification which recognises the ability to gain, and
where relevant apply a range of knowledge, skills and understanding.
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ICM Diploma holders should be able to display competence in the application of knowledge
in a broad range of varied work activities performed in a wide variety of contexts, most of
which are complex and non-routine.
Learning at this level involves obtaining detailed knowledge and skills appropriate for people
working independently, or providing basic supervision and training of others in their field of
work and people wishing to go to University.
Progression is available from the ICM Diploma to the second year of relevant degree
programmes at a range of Universities. For a complete list of progression routes please refer
to the website.
5.3 ICM Advanced Diplomas (equivalent to NQF Level 6 Diplomas)
Entry to an ICM Advanced Diploma programme requires completion of the ICM Certificate
and Diploma in the selected programme. Students holding other relevant and equivalent
qualifications which contain ICM Diploma subjects could qualify for entry as well as subject
and Level exemptions.
ICM Advanced Diplomas represent a level of qualification which involves specialist learning
and detailed analysis of a high level of information, knowledge and skills in a specified area
of work or study.
Students undertaking an ICM Advanced Diploma should demonstrate the depth of
knowledge and understanding of an area of work or study to enable them to formulate
solutions and responses to complex problems and situations.
ICM Advanced Diplomas are appropriate for people working in positions such as Senior
Supervisors, Professionals or Managers. These individuals need to demonstrate significant
levels of knowledge, a high level of work expertise in job roles and competence in managing
and training others. Learning at this level is appropriate for people working in technical and
professional jobs, and/or managing and developing others.
The ICM Advanced Diploma is equivalent to NQF Level 6 and in terms of level and credit
value these qualifications are comparable to UK Intermediate Higher Education qualifications
such as HNDs, Diplomas of Higher Education and Foundation Degrees.
Progression is available from ICM Advanced Diplomas to the final year of relevant degree
programmes at a range of Universities. For a complete list of progression routes please refer
to the website.

5.4

ICM Graduate Diplomas (equivalent to NQF Level 6 Diplomas)

Entry to an ICM Graduate Diploma programme requires prior completion of the ICM Diploma
and Advanced Diploma in the selected programme.
Advanced Standing and Exemptions: Students holding relevant degrees and equivalent
qualifications which contain ICM Certificate, Diploma and Advanced Diploma subjects could
qualify for entry as well as subject and Level exemptions.
Students at this level study highly developed and complex levels of knowledge enabling the
development of in-depth and original responses to complicated and unpredictable problems
and situations.
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Learning at the Graduate Diploma level involves the demonstration of high level specialist
professional knowledge appropriate for senior professionals and managers. Indicative
competencies involve the application of a range of fundamental principles across a wide and
often unpredictable variety of contexts as well as the ability to perform technical or
professional work activities in a variety of contexts with a substantial degree of personal
responsibility and autonomy.
A qualification at this level is appropriate for people working as knowledge-based
professionals or in professional management positions. This qualification is equivalent to a
Bachelors degree, and progression is available from the ICM Graduate Diploma to Post
Graduate programmes such as Masters degrees.
5.5 ICM Post Graduate Diplomas (equivalent to NQF Level 7 Diplomas)
Entry to an ICM Post Graduate Diploma programme requires completion of an ICM
Graduate Diploma, another Level 6 award, or a degree level qualification in an appropriate
discipline.
Refer to Section 6 for Advanced Standing arrangements for mature candidates.
Students at this level of study should display a mastery of high level knowledge and skills
and have professional and research-based skills.
This qualification is equivalent to two thirds of a Masters degree (MBA or MA) and advanced
standing can be given onto a range of Masters degrees. For a complete list of progression
routes please refer to the website.

5.6

Relative Positioning of ICM Qualifications

The following table gives an indication of the relative positioning of ICM awards, compared
with other types of qualifications and levels. Reference is made to levels in the UK National
Qualifications Framework and example qualifications at each level. In addition, the final
column in the table (FHEQ) shows the ‘equivalent’ qualifications commonly being developed
and delivered in the University sector. For example, these indicate that the ICM Advanced
Diploma equates to an intermediate level award (in terms of credit accumulation this ICM
qualification equates to a Higher National Diploma). Furthermore, the ICM Graduate Diploma
equates to a Bachelors degree level qualification and the ICM Post Graduate Diploma
equates to a Masters degree level qualification.
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Relative Positioning of ICM Qualifications

National Qualifications Framework
Framework for
(Levels and example vocational
ICM Levels
qualifications)
Level 7
Professional Diploma in Translation

Level 6
Diploma in Management

ICM Post Graduate
Diploma
(Level 7 Diploma)

M (masters), Masters
degrees, Post Graduate
certificates and diplomas

ICM
Graduate Diploma
(Level 6 Diploma)

H (honours)
Bachelors degrees
(BSc/BA)

ICM
Advanced Diploma
(Level 6 Diploma)

I (intermediate)
Diplomas of higher
education, foundation
degrees, Higher National
Diplomas

Level 5
ICM Diploma
BTEC Higher National Diploma in 3D
(Level 5 Diploma)
Design
Level 4
Certificate in Early Years Practice

Framework for
Higher Education
Qualification Levels
(FHEQ)

ICM Diploma
(Level 5 Diploma)

C (certificate)
Certificates of higher
education

Level 3
Certificate in Small Animal Care
NVQ in Aeronautical Engineering
A levels
Level 2
Diploma for Beauty Specialists
NVQ in Agricultural Crop Production
GCSEs Grades A*-C
Level 1
Certificate in Motor Vehicle Studies
NVQ in Bakery
GCSEs Grades D-G
Entry – e.g. Entry Level Certificate in
Adult Literacy
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Student Registration & Course/Level Entry Requirements

6.1 Student Registration
In order to undertake any ICM examination candidates must be Registered ICM Student
Members.
Student Membership can be obtained by completing the appropriate Student Registration
Application form and returning the form and the Student Registration Fee to the Institute.
Details of Student Registration Fees can be found on the ICM website.
The Student Registration fee is valid for one year and can be renewed annually.
Important Note: All students wishing to register for any ICM Advanced Diploma
programme or above, MUST complete and attach an Academic History form to their
Student Registration form. Copies of all qualifications and Awards obtained by the
student must also accompany the Academic History form.
The Academic History form is used to ensure that students are qualified to commence
their studies at the Level they have selected.

6.2 Student Registration Fees
Student Registration fees for standard ICM Awards and programmes are based on the
country in which you will undertake your examinations. The current fees levels are as
follows:
Group 1: If you are based in Europe, and EU Member State, North America, a Gulf
State, India, the Middle East, Australasia, Singapore, South Africa, China,
Hong Kong or Malaysia your Registration Fee will be £50.00.
Group 2: If you are based in sub-Saharan Africa, Central or South America,
Pakistan, Bangladesh, the Caribbean or North Africa your Registration
Fee will be £25.00.
Group 3: A special rate exists for students in countries which have (a) emerged
from conflict (b) countries in which the general population is subject to
great poverty and (c) countries in which the UN acknowledge that the level
of economic activity and national per capita income is unacceptably low.

6.3

Course/Level Entry Requirements

ICM professional programmes are structured in ‘Levels’. These Levels are designed to
provide a structured and progressive level of knowledge.
All students are required to commence their studies at the Diploma Level of all programmes
unless they are able to claim subject-for-subject or Level exemptions.
Subject-for-subject exemptions can be applied for if the student has (a) been examined, in
the subject, by another recognised Awarding body and (b) has passed the examination/s set
by the alternate body.
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The Institute operates an 'Open Entry' policy in respect of most of its Diploma Level
vocational programmes, subject to appropriate work experience, but prospective students
should note that the following qualifications are recommended for those wishing to undertake
ICM Diploma Level programmes:

Entry to an ICM Diploma Level Programme (NQF Level 5)
Entry to an ICM Diploma programme requires completion of secondary education or
equivalent. For example:
 One GCE A-level plus three GCSEs (or equivalents) or 5 GCSEs
 A suitable BTEC National Award
 Any qualification equivalent to one or more of the above
The minimum age for registration for the majority of programmes is 18. Applicants over the
age of 20 who do not hold one of the recommended entry qualifications may also register for
some Diploma Level programmes providing they have been in full-time employment for a
minimum of two years and can produce a letter from their employer to confirm this.

Entry to an ICM Advanced Diploma Programme (NQF Level 6)
Entry to an ICM Advanced Diploma programme requires completion of the ICM Diploma
Level of the selected programme.

Entry to an ICM Graduate Diploma Programme (NQF Level 6)
Entry to an ICM Graduate Diploma requires completion of the ICM Diploma and Advanced
Diploma in the selected programme.

Entry to an ICM Post Graduate Diploma Programme (NQF Level 7)
Registration for an ICM Post Graduate Diploma is accepted from those:
 who have completed an ICM Graduate Diploma
 who hold any Level 6 business or management Award
 holders of business and management degree level qualifications.
Mature Candidates. Applications from those over the age of 25 who do not meet the
standard Entry Requirements will also be considered providing they:
 Are over the age of 25
 Have been in employment for 5 years – a letter of support is required from the
applicant’s employer; and
 Hold a management or senior supervisory position.
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7

Examinations and Results

7.1 Examinations
In order to achieve a consistent global standard the Institute sets all examination papers and
all candidate scripts are returned to the Institute for marking.
Invigilation of examinations is undertaken either by external Invigilators who are appointed
by the Institute or by the British Council. Examinations are held in March, June, September
and December and the Examination Timetable can be found on the ICM website.
Candidates must be registered and paid-up Student Members of the Institute at the time they
undertake their examinations. Examination papers are securely distributed to ICM Approved
Centres and scripts are assessed and moderated in the UK by ICM Appointed Examiners.
Full details of Examination dates can be found on the ICM website.
7.2 Examination Entry Fees and Forms
Examination Entry fees are shown on the appropriate Examination Entry form for the
subject/programme you are undertaking. In general, the standard Examination fee is £26.00
per subject. There are however some specialist programmes where a higher subject fee may
be payable. If you have any queries relating to fees please contact your Teaching Centre.
In order to undertake any ICM Professional or Single Subject examination you must be a
Registered and paid-up ICM Student Member.
To enter for an examination you need to complete the relevant Examination Entry form and
submit it to the Institute.
7.3 Examination Timetable
ICM examinations take place four times each year, in March, June, September and
December. The Timetable for each year states the Closing Date for receipt of entries for
each examination Series. Please visit the website to view the ICM examination timetable.
7.4

Examination grades and re-marking

You can request that your examination script is re-marked if you are unhappy with your
result.
The fee for this is GBP £35.00 per script. The Institute operates a triple marking and
moderation system. In the event that the moderator increases the original marks awarded,
the fee for re-marking your script will be refunded to you. Should the Grade awarded remain
the same, you will be issued with a full Examiner’s Report detailing your examination
performance. The Institute retains answer scripts for a maximum period of six months.
Examination scripts/answer books are not returned to candidates under any circumstances.
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7.5

Examination re-sits

Although ICM Examinations are held every twelve weeks it should be noted that it takes an
average of twelve weeks to mark the scripts after each Examination Series.
If you sit, for example, for one or more subjects in March you will not receive your results
until June. This means that if you were to fail a subject in March, you would not be able to resit the subject in June, as you will have missed the Closing Date for the June Series.
Our advice is that you try to split your subject examinations between two consecutive
Examination Series e.g. If your programme has four subjects you could take two subjects in
one series and two in another series.
On this basis, were you to fail one subject in March you would be able to re-sit it in
September, giving you plenty of time for revision.

7.6

Examination Closing Dates

There is a Closing Date for receipt of Examination Entries and candidates entering for
examinations must ensure that their completed Examination Entry forms and fees reach the
Institute before the Closing Date for each Examination Series. Examination Timetables
indicate the closing date for receipt of entries for each sitting and this information also
appears on the ICM website. Entries received after the Closing Date are automatically
carried forward to the next Examination Series.
7.7

Examination Results

Results are distributed within twelve weeks from receipt of scripts. Candidates are advised
not to telephone the Institute for results as this information is confidential and cannot be
disclosed over the telephone.
7.8

Examination Grades

Should you wish to re-sit any examination to improve your previous Grade, please note that
the latest Grade you obtain will stand.
7.9

Transcript of Academic Results

You may request a transcript of your Academic Results, however please note there is a
charge of GBP £15 for each Award transcript requested.
7.10 Replacement Certificates
Replacement certificates are available on payment of a fee of GBP £20.00 per certificate.
Please include your Student Registration Number together with your current postal address
and indicate which certificate is required.
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7.11 Deferrals
There is a fee of GBP £15.00 per subject should you wish to defer your examinations to
another Series for health or for any other reason. If you are unable to undertake your
examinations, it is essential you advise ICM before the appropriate examination date,
otherwise the full entry fee of GBP £26.00 will be applicable. Please note that you may only
defer examinations on one occasion. The full entry fee of GBP £26.00 per subject will
become due if you defer on more than one occasion.
7.12 Subject Exemptions for Professional Programmes
Students holding relevant recognised qualifications from other professional bodies or
recognised Higher Education institutions may apply for Subject Exemptions, on a subject-forsubject basis. It may also be possible, subject to qualifications held, to obtain exemption
from a Level within a programme. Documentary evidence is required before any decision
can be made in connection with the granting of Subject/Level Exemptions. No exemptions
are given for case studies or assignments. Internally awarded school certificates and
diplomas are not accepted for exemption purposes.

7.13 Single Subject Candidates
Registered ICM students who do not want to complete a full ICM programme may study
individual subjects. Single Subject candidates receive a Single Subject Diploma on
successful completion of the relevant subject examination. Single Subjects qualify, on a
subject-for-subject basis, for subject exemptions from ICM professional programmes.
Note: 1. Case Studies, Assignments and Projects, including ALL subjects in any Post
Graduate programme, do not qualify for Single Subject Awards.
2. A student who undertakes, on a Single Subject basis, subjects within a Diploma,
Advanced Diploma, Graduate Diploma or Post Graduate ICM programme will not
be entitled to a professional Award unless they are exempted from or have
completed all lower Levels of that Award.
3. In order to comply with UKBA requirements, overseas students studying in the UK
(excluding those from EU countries) are not permitted to undertake Single
Subjects and must undertake a professional programme.
8

Subject advice, educational guidance and student support

You are expected to be independent and to take responsibility for your own academic and
personal life. However, your study centre should also provide appropriate help and
assistance. Your tutors will direct your studies and ensure that you know what work you
need to cover in any given unit. Seek advice from academic staff either during or after class
or try to see them during their office hours.

8.1 Study Methods
Teaching Centres are provided with a detailed syllabus and reading list for each subject
area. Each Unit Syllabus clearly defines the areas that you will be required to cover for each
subject and your examination questions will be based on the areas and topics detailed for
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each unit. It is important to ensure that you obtain a copy of each unit syllabus from your
Teaching Centre. Alternatively, this information can be obtained online at
www.icm.education, in the ‘Single Subject’ section.
Each Unit Syllabus is normally linked to one main textbook and the examiners base their
questions on the contents of the nominated core text.
The Unit Syllabuses also give details of 'Alternative Texts' and texts recommended for
further reading. It is advised that you should refer to the 'Alternative Texts' in order to
develop your skills and broaden your knowledge of the subject area.
8.2 Payment Methods
Registration and Examination fees can be paid by any one of the following methods:







Sterling Bank Draft
Sterling Money Order
Sterling Postal Order
Sterling Cheque (if drawn on a UK Bank). Cheques should be made payable to ICM
Sterling Cash (this needs to be registered – this option is available in the UK ONLY)
Credit Card - you may download this form from our website
http://www.icm.education/forms. (Please be aware there is a £5.00 Pounds Sterling
Administration Charge for this service and this form can only be accepted as a hard
copy by post)
 Western Union - if you wish to use Western Union you may utilise one of the
following payee's names:
‘Jackie Cleaver’
'Adair Somerville Ford’
‘Alistair Somerville Ford’
It is ESSENTIAL that you provide us with the Money Transfer Control Number
(MTCN) you are given by Western Union. If payment is made for examinations, the
Money Transfer Control Number MUST be clearly written on your examination
entry form. If you propose to send your fees through Western Union please confirm
by email to info@icm.education that payment has been made by this method.
Please note that it is not ICM policy to provide our Bank account details, and you are
therefore requested to use one of the above accepted payment methods.
8.3 Choosing your course of study
As an ICM Student Member you can work towards obtaining either a recognised
Professional qualification or study for one or more of the 200 Single Subject Awards from the
list of subjects offered by the Institute. The choice is yours.
8.4 ICM Approved Centres
Tuition leading to the Institute’s examinations can only be provided by Institutions which
have been granted ICM ‘Approved Centre’ status. Please note that some ICM Teaching
Centres specialise in particular subject areas and not all ICM Centres will necessarily offer
tuition for every ICM course programme. Visit the website to find an ICM Approved Centre
near you.
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Textbooks

The recommended textbooks for each subject are shown on each subject syllabus.
Examiners base their questions on the contents of the recommended texts and it is therefore
important for you to ensure that you have access to the appropriate texts. You can obtain the
full list of books available to purchase from ICM and/or place orders by either contacting your
Centre or complete the Book Order Form and send it to ICM’s Book Sales Manager at:
info@icm.education .
10 Students with specific learning difficulties
If you are diagnosed with a specific learning difficulty you may be granted special
arrangements for your examination/s. We will require a copy of an Assessment Report
issued within the last three years. The amount of additional time and any other
arrangements will be determined on the basis of the Report relating to your circumstances. It
is possible that you may be granted permission to use a computer or laptop without internet
connection in your examinations.
11 Copies of past examination papers and other forms of assessment
The ICM website, www.icm.education, provides a database of recent examination papers,
assignments and Case Studies. These can be found in the Student Resources section of the
website.
12 Unit Information
Continuing expansion in World Trade has led to an increase in management career
opportunities for those with the relevant knowledge, ability and commercial experience in
International Trade.
This two part business programme provides, at certificate level, the knowledge necessary for
the administration of an import/export office. The diploma level is designed for those who,
having gained relevant practical experience, seek a senior appointment as an Export Sales
Manager or Export Sales Director.
12.1 Programme Objectives
This programme provides students with the practical skills and knowledge required for
export/import office duties, documentation, export/import procedures and the handling of
orders. The knowledge gained is designed to ensure that on completion of the course
students are able to undertake export/import clerical duties with confidence.
On completion of both the Certificate and Diploma levels, graduates who have gained
suitable practical experience should be able to:
 establish, organise and control an Export Department on behalf of a company
 identify new markets and develop entry and distribution strategies
 appreciate the macroeconomic differences between countries
 develop their own international trade operation.
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12.2 Recommended Course Duration
To help calculate the duration of the programme, please refer to section 4.2 entitled ‘Student
Work Load’. It is expected that a student will need at least 12 months of full-time study at an
ICM Approved Centre (6 months for each level) to complete this programme.

12.3 Examination Grades
Grade A - Distinction
Grade B - Credit
Grade C - Pass
Grade D - Marginal Pass
Grade F - Fail

70% and above
60% to 69%
50% to 59%
40% to 49%
39% and under

Certification
On successful completion of all the examinations in Part 1 students are awarded the ICM
Certificate in International Trade and on successful completion of all the examinations in
Parts 1 & 2 students are awarded the ICM Diploma in International Trade.
12.4 Continuing Education
The Diploma in International Trade will serve as an excellent route for students who
ultimately seek full professional status and will provide first class underpinning knowledge for
the mainstream UK based degrees in international business.
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13 Course Structure
The Diploma in International Trade – Part 1
1 Business Management & Administration
2 Economics for Business
3 International Business Communications
4 International Marketing
5 International Trade & Payments I
The ICM Certificate in International Trade is awarded on completion of all 5 subjects in
Part 1

The Diploma in International Trade – Part 2
6 Export Practice & Management
7 International Marketing Research
8 International Trade & Payments II
9 International Trade & Transport
10 The International Business Environment
The ICM Diploma in International Trade is awarded on completion of all 10 subjects in Part 1
and Part 2

13.1

Unit Syllabuses

Syllabuses for this programme are contained in the following sections.
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13.1.1 Business Management & Administration Syllabus

Unit Title

Business Management & Administration

Unit Code

BMA-0605

Level

4 Diploma

Credits

20

Unit Leader

GW

Pre-requisites
Main Aim(s) of the Unit:
The unit introduces the student to a range of studies which are useful in understanding people in the
workplace. It examines the concept of management within the global business environment and
through the appraisal of business cases, a variety of approaches are considered.
The unit prepares students for their likely future roles as managers in organisations. It encourages
them to synthesise knowledge and experience gained in other units by considering competing
perspectives on the nature of management. It encourages them to reflect upon the contribution that
they might make as individuals to the management process, and to explore their own skills as
potential managers, within the context of their peer group. The unit touches practical, moral and
ethical dimensions of the management role and examines the key problems and dilemmas that may
emerge for stakeholders in contemporary organisations.
Main Topics of Study:
The Organisational Background to Business Administration
The Management Framework to Business Administration
► What are Business Administration and Management?
► The Board of Directors
► Functions within an Organisation
► The 'Systems' Approach to Organisation
► Planning-Control Feedback Cycles
Characteristic Features of Organisations
► The Structure of Organisations and the Need for Authority
► The Features of Bureaucratic and Non-Bureaucratic Organisations
► Traditional Principles and Types of Organisation
► More about Systems & Subsystems
The Structure of Business Enterprises
► The Pattern of Organisations
► Business Types including; Sole-Trader Enterprises, Partnerships, Limited Partnerships, The
Limited Liability Company, Non-Profit-Making Units (Clubs & Societies), Public Enterprises
► Public Sector Organisations; Autonomous Public Corporations, Nationalised Industries, Local
Government Institutions, Central Government Departments
Functions within Organisations
The Production Function
► The Production Process and Types of Production
► Site Selection & Factory Planning
► Plant & Equipment
► Materials & Materials Handling
► Production Administration
► Costing Aspects of Production
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► Work Study
► Maintenance & Production
► CAD, CAM & CIM
The Purchasing Function
► The Nature of Purchasing and the Role of the Purchasing Officer
► Purchasing Department Procedures, Inventory Control, Stores Control and Economic Order
Quantity
The Research & Development Function
► The Functions of the Research & Development Department
► Basic Research
► Problem-Based Research
► Ideas Generation
► Applied Research & Development
► Patents, Trade Marks & Service Marks
► Research & Development in the Business Organisation
The Marketing Function
► Introduction to Marketing and the Marketing Philosophy
► Market Analysis & Research
► Promotion, Publicity & Public Relations
► Pricing Policy
► Credit Control
► Sales Administration
► Transport & Distribution (Logistics)
► Export Marketing
Personnel Department
► The Need for Staff
► The Functions of the Personnel Department and a Personnel Policy
► Employee Records
► Promotion, Transfer, Termination & Dismissal
► Industrial Relations Practice
► The Remuneration of Staff
The Administrative Officer’s Role
Office Administration
► The Role of the Administrative Officer
► Facilities Management - The 'New-Look' Office Administrator
► The Office & its Functions
► The Clerical Function, Business Correspondence, Mail Inwards, Mail Outwards, Systems for
Producing Business Correspondence
► Meetings, Conferences, Functions and Delegation
Other Responsibilities of the Administrative Officer
► The Organisation & Methods Department
► Security Aspects of Business
► Risk Management
► The Environment of Organisations
► What is a Claimant?
► Assessing the Impact of Claimants
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Learning Outcomes for the Unit:
At the end of this Unit, students will be able to:
1.

Provide critical evaluation of the major functional areas of a business and describe their
interrelationship.

2.

Evaluate competing perspectives on the nature of management as both a function and process
within organisations.

3.

Discuss the concept of managerial power and authority, in the context of the work of individual
managers, and organisations within their social and cultural contexts.

4.

Discuss models of managerial decision-making.

5.

Discuss the development of organisations in their historical, social and cultural contexts, and the
choices that this creates for the management of organisations.

6.

Explain the process of organisational change and development.

7.

Discuss management as a moral and ethical process.

8.

Demonstrate an appreciation of the role of the Administrator as part of the Managerial process.

The numbers in the boxes below show which of the above unit learning outcomes are related
to particular cognitive and key skills:
Knowledge &
Understanding

Analysis

Synthesis
/Creativity

Evaluation

Interactive &
Group Skills

Self-appraisal/
Reflection on
Practice

1-8

1,2,4,7

1,2

1,2,7,8

-

-

Planning and
Management of
Learning

Problem
Solving

Communication
& Presentation

Practical/Psycho
-motor Skills

Other skills
(please
specify):

-

1,2

1-8

-

-

Learning and teaching methods/strategies used to enable the achievement of learning
outcomes:
Learning takes place on a number of levels through lectures, class discussion including problem
review and analysis. Formal lectures provide a foundation of information on which the student builds
through directed learning and self managed learning outside of the class. The students are actively
encouraged to form study groups to discuss course material which fosters a greater depth learning
experience.
Assessment methods which enable the student to demonstrate the
learning outcomes for the Unit:

Weighting:

Examination: 3 hours duration

100%

Indicative Reading for this Unit:
Main Text
Business Management & Administration, Whitehead, G. & Whitehall, G., Institute of Commercial
Management
Alternative Texts and Further Reading
Modern Business Administration, Appleby, R.C., Pitman
The Structure of Business, Buckley, M., Pitman
Students should also be prepared to read other suitable accounting text books
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Guideline for Teaching and Learning Time (10 hrs per credit):
50 hours

Lectures / Seminars / Tutorials / Workshops
Tutorial support includes feedback on assignments and may vary by college according
to local needs and wishes.

50 hours

Directed learning
Advance reading and preparation / Class preparation / Background reading / Group
study / Portfolio / Diary etc.

100 hours

Self managed learning
Working through the course text and completing assignments as required will take up
the bulk of the learning time. In addition students are expected to engage with the tutor
and other students and to undertake further reading using the web and/or libraries.
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13.1.2 Economics for Business Syllabus

Unit Title

Economics for Business

Unit Code

EB-0605

Level

4 Diploma

Credits

20

Unit Leader

BF

Pre-requisites
Main Aim(s) of the Unit:
This unit examines the main concepts of economic theory and their importance within a business
framework. Throughout the unit the emphasis will be on the applicability of business and the external
circumstances under which business operates. The aim is to provide the necessary knowledge, tools
and understanding of economics as a basis for the study of business.
Main Topics of Study:
The Nature & Scope of Economics
► The Development of Economic Society
► The Economic Problem: Scarcity Choice and Opportunity Cost
► Alternative Economic Systems
Production
► The Economic Background to Production
► Specialisation and the Division of Labour
► Business Organisations
► Factors of Production
► The Scale of Production and Economies of Scale
► The Location of Production
The Theory of Price Determination
► Demand
► Supply
► Price Determination
► Concept of Elasticity
► Applications of the Demand and Supply Model
Market Structures
► Competitive Markets – the Institutions where Price is Decided
► Monopoly
► Oligopoly
► Imperfect Competition (Monopolistic Competition)
► Public Policy Towards Competition
Factor Markets and Rewards to Factors
► Rewards to Factors: Distribution Theory
► Land & Rent
► Labour & Wages
► Capital & Interest
► Entrepreneurship & Profit
► Economic Rent
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Market Failure
► Market Imperfections
► Externalities
► Public Goods and Merit Goods
► Imperfect Information
► Dealing with Market Failure
Money & Banking
► Functions of Money
► Financial Institutions
► Central Banking
Macroeconomics
► Basic National Income Accounting
► Use of National Income Statistics
► Economic Policy
► Circular Flow Analysis
► Consumption, Savings and Investment
► National Income Equilibrium
► Multiplier and Accelerator
Unemployment & Inflation
► Types of Unemployment
► Costs of Unemployment
► Causes of Inflation
► Costs of Inflation
Economic Policy Instruments
► Taxation, Government Spending and Budgets
► Fiscal Policies
► Money and Monetary Policy
► Supply Side Measures and Privatisation
International Trade
► Absolute & Comparative Advantage
► The Principle of Free Trade
► Protection – Types and Causes
► Free Trade, Customs Unions and Single Markets
► The European Union and Other Free Trade Areas
► GATT and WTO
► Balance of Trade and Payments
► Dealing with Balance of Payments Problems.
Globalisation and International Monetary Issues
► Exchange Rate Determination
► Fixed and Floating Exchange Rate Systems
► Trade and Economic Development
► Transnational Enterprises
► Globalisation

International Trade

22

Learning Outcomes for the Unit:
At the end of this Unit, students will be able to:
1.

Demonstrate an understanding of the main economic theories about the firm and its market.

2.

Critically evaluate the usefulness of these theories in understanding the operation of business.

3.

Demonstrate knowledge of the relationship between economics and management.

The numbers in the boxes below show which of the above unit learning outcomes are related
to particular cognitive and key skills:
Knowledge &
Understanding

Analysis

Synthesis
/Creativity

Evaluation

Interactive &
Group Skills

Self-appraisal/
Reflection on
Practice

1-3

1

2

2

-

-

Planning and
Management of
Learning

Problem
Solving

Communication
& Presentation

Practical/Psycho
-motor Skills

Other skills
(please
specify):

-

-

-

-

-

Learning and teaching methods/strategies used to enable the achievement of learning
outcomes:
Learning takes place on a number of levels through lectures, class discussion including problem
review and analysis. Formal lectures provide a foundation of information on which the student builds
through directed learning and self managed learning outside of the class. The students are actively
encouraged to form study groups to discuss course material which fosters a greater depth learning
experience.
Assessment methods which enable the student to demonstrate the learning
outcomes for the Unit:

Weighting:

Examination: 3 hours duration

100%

Indicative Reading for this Unit:
Main Text
Economics: A background text, Forster, B. and Whitehead, G., ICM
Student Handbook for Economics: A background text, Forster, B. and Whitehead, G., ICM
Alternative Texts and Further Reading
Business Basics in Economics for first year degree students, BPP Publishing
Essentials of Economics, Sloman, J., Prentice Hall
Guideline for Teaching and Learning Time (10 hrs per credit):
50 hours

Lectures / Seminars / Tutorials / Workshops
Tutorial support includes feedback on assignments and may vary by college according
to local needs and wishes.

50 hours

Directed learning
Advance reading and preparation / Class preparation / Background reading / Group
study / Portfolio / Diary etc.

100 hours

Self managed learning
Working through the course text and completing assignments as required will take up
the bulk of the learning time. In addition students are expected to engage with the tutor
and other students and to undertake further reading using the web and/or libraries.
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13.1.3 International Business Communications Syllabus

Unit Title

International Business Communications

Unit Code

IBC 101-05

Level

4 Diploma

Credits

20

Unit Leader

JF

Pre-requisites
Main Aim(s) of the Unit:
To prepare students to address business communication situations encountered in their careers
through the writing of memoranda, letters, reports, résumés, electronic messages; manuals with
terms, mechanisms and instructions; process analysis; proposals; web portfolios; delivering oral
presentations, in order to develop interpersonal skills and to foster critical thinking and problemsolving skills through the writing of effective communication for assigned business scenarios /
situations.
Main Topics of Study:
The process of communication
► The objectives of communication
► The meaning of words
► Non-verbal communication
► The context or situation
► Barriers to communication
► Why? Who? Where? When?
► What? How?
► Planning the message
► Summary – how to communicate
Speaking effectively
► Basic speaking skills
► Qualities to aim for when speaking
► Summary – good speaking
Listening
► Listening - the neglected skill
► Reasons for improving listening
► Are you a good listener?
► Ten aids to good listening
► Summary – good listening
Human interaction and non-verbal communication
► Metacommunication and paralanguage
► The language of silence
► The language of time
► Body language or kinesics
► The underlying psychology: NLP, El and TA
► Conflict between verbal and non-verbal communication
► Summary – the importance of paralanguage in human interaction
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Talking on the telephone
► Telephone problems
► Basic telephone rules
► Receptionists
► Making a call
► Gathering information by telephone
► Answering the telephone
► Voicemail
► Mobile phone manners
► Summary – good telephoning
Interviewing
► Interviewing weaknesses
► What is an interview?
► The purposes of the interview
► Types of interview information
► How to plan an interview
► Structuring the interview
► How to question and probe
► Summary – Interviewing
Being interviewed for a job
► Preparing – the organisation
► Preparing – know yourself
► At the interview
► Tips to remember
► Summary – being interviewed for a job
Communicating in groups
► Advantages of groups
► Disadvantages of groups
► Factors affecting group effectiveness
► Summary – making groups and committees work
Running and taking part in meetings
► Chairing meetings
► Decision-making methods
► Responsibilities of participants
► Duties of officers and members
► The agenda
► The minutes
► Video- conferencing and audio-conferencing
► Formal procedure
Giving a talk
► Techniques of public speaking
► Preparation
► Developing the material
► Opening the talk
► Closing the talk
► Visual aids
► Use of notes

International Trade

25

► Practising the talk
► Room and platform layout
► Delivery of the talk
► Summary – being a good speaker
Using visual aids
► General principles
► Whiteboards, electronic copy boards, interactive boards
► Flip charts
► Build-up visuals
► Physical objects
► Models and experiments
► Overhead projector (OHP)
► Data projector or multimedia projector
► 35mm slide projector
► Videos and DVDs
► Closed circuit television and video
► Points to remember about visual aids
► Video and DVD hire and purchase
► Summary – being in control of visual aids
Faster reading
► How do you read?
► The physical process of reading
► Ways of increasing your vocabulary
► Summary – faster reading
Better reading
► Determine reading priorities
► Scanning
► Skimming
► SQ3R method of reading
► Summary – better reading
Writing business letters
► Why good letter-writing matters
► Backing up the phone call or meeting
► Planning a letter
► Layout and style
► The structure of a letter
► Dictating
► Standard letters
► Summary – writing business letters
Applying for a job
► What sort of job do you want?
► What is available and what are they looking for?
► The application itself
► Job-hunting on the Internet
► Summary – applying for a job
Writing reports
► What is a report?
► Types of report

International Trade

26

► Essentials of a good report
► What is the purpose of the report?
► Fundamental structure
► Format, layout, headings and numbering
► Long formal reports
► House style
► How to get started
► Setting your objective
► Researching and assembling the material
► Organising the material and planning the report
► Writing the first draft
► Editing the report
► Producing the report
► Summary – report writing
Memos, messages, forms and questionnaires
► Memos
► E-mail
► Fax
► Postcards and reply cards
► Text messaging
► Forms and questionnaires
► Summary – other writing tasks
Visual communication
► When to use charts and graphs
► Presentation of statistical data
► Presenting continuous information
► Presenting discrete or non-continuous information
► Presenting non-statistical information effectively
Getting to grips with grammar
► Why does grammar matter?
► What is grammar?
► How good is your English?
► The parts of speech in brief
► The framework of English
► The architecture of the sentence
Common problems with English
► Subject–verb agreement
► Problems with verbs
► Problems with adjectives
► Problems with adverbs
► Problems with pronouns
► Problems with prepositions and conjunctions
► Problems with ellipsis
► Problems with negatives
► Revision of grammar
Appendices
► A Punctuation made easy
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►
►
►
►
►
►
►
►

B Using capitals
C Using numbers
D Business clichés or 'commercialese'
E Commonly misused and confused words
F Ten (simple?) rules of spelling
G Commonly misspelled words
H Tips on modern business style
I Differences between men and women communicating

Learning Outcomes for the Unit:
At the end of this Unit, students will be able to:
1.

Demonstrate how business communication strategies and principles can be applied to prepare
effective communication for domestic and international business situations.

2.

Discuss the relative merits of and appropriate organisational formats and channels used in
developing and presenting business messages.

3.

Demonstrate an understanding of the mechanics of oral and written communication including
presentations, memos, letters, and reports.

4.

Demonstrate language skills competency in grammar, spelling, punctuation, capitalization,
number usage, and sentence structure by communicating in concise, clear, straightforward
language.

5.

Explain relative merits and mechanisms for communicating via electronic mail, Internet, and
other electronic media.

6.

To deliver an effective oral business presentation (Non credit bearing assessment).

7.

To demonstrate problem-solving and critical-thinking skills by analysing business problems,
resulting in functional business documents, memoranda, letters, and/or reports.

Learning and teaching methods/strategies used to enable the achievement of learning
outcomes:
Learning takes place on a number of levels through lectures, class discussion including problem
review and analysis. Formal lectures provide a foundation of information on which the student builds
through directed learning and self managed learning outside of the class. The students are actively
encouraged to form study groups to discuss course material which fosters a greater depth learning
experience.
Assessment methods which enable the student to demonstrate the learning
outcomes for the Unit:

Weighting:

Examination: 3 hours duration

100%

Indicative Reading for this Unit:
Main Text
Mastering Communications, Stanton, Nicky, (5th edition), Palgrave Macmillan
Alternative Texts & Further Reading
Practical Communications, Bergin, F.W., Pitman
People of Communication, Evans, D.W., Pitman
Basic Business Communication, Lesikar, K., McGraw Hill
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Guideline for Teaching and Learning Time (10 hrs per credit):
50 hours

Lectures / Seminars / Tutorials / Workshops
These interactive sessions will be used to discuss concepts and allow students to
present findings.

50 hours

Directed learning
Advance reading and preparation / Background research / individual and group
preparation for seminars.

100 hours

Self managed learning
Working through the course text and completing assignments as required will take up
the bulk of the learning time. In addition students are expected to engage with the tutor
and other students and to undertake further reading using the web and/or libraries.
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13.1.4 International Marketing Syllabus

Unit Title

International Marketing

Unit Code

IMK-0506

Level

4 Diploma

Credits

20

Unit Leader

NK

Pre-requisites
Main Aim(s) of the Unit:
The main aim of this unit is to expand and develop the themes introduced in earlier courses by
applying an international dimension. Students should develop an appreciation for the interplay
between marketing, trade and economics and understand key issues in current international
marketing by applying theoretical concepts to case studies as available.
Main Topics of Study:
Introduction to International Marketing
► The Strategic Importance of International Marketing
► The International Marketing Environment
► Differences Between International and Domestic Marketing
► International Marketing Strategies
The International Trading Environment
► World Trading Patterns
► Reasons Countries Trade
► Barriers to World Trade
► The Development of World Institutions to Foster International Trade
► The Development of World Trading Groups
► The European Union
► The Free Trade Area of the Americas (FTAA)
► The Asian Pacific Trading Region
► The Chinese Economic Area
Social and Cultural Considerations in International Marketing
► Social and Cultural Factors
► What is Culture?
► Culture and Consumer Behaviour
► Analysing Cultures and the Implications for Customer Behaviour
► Cross-cultural Analysis
► Social and Cultural Influences in Business-to-Business Marketing
International Marketing Research and Opportunity Analysis
► The Role of Marketing Research and Opportunity Analysis
► The Role of International Marketing Research
► Opportunity Identification and Analysis
► International Marketing Segmentation
► Transnational Segmentation
► Problems of Using Secondary Data
► Primary Research in International Markets
► Research Design & Survey Methods
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International Niche Marketing Strategies for Small and Medium- sized Enterprises (SMEs)
► The SME Sector and its Role Within the Global Economy
► The Nature of International Marketing in SMEs
► The Nature of International Development
► International Strategic Marketing Management in SMEs
► Ansoff Matrix MC Kinsey Framework
► Factors Affecting Choice of International Marketing Strategy
► Management Style and International Fast Growth
► The Future of SME Internationalisation
Global Strategies
► Alternative Views of Globalisation
► Alternative Strategic Responses
► Multi-domestic Strategies
► International Marketing Management for Global Firms
► Organisational Structure for Transnational Firms
Market Entry Strategies
► The Alternative Market Entry Methods
► Indirect Exporting
► Domestic Purchasing
► Export Houses
► Piggybacking
► Trading Companies
► Direct Exporting
► Agents
► Management Contracts
► Foreign Manufacturing Strategies without Direct Investment
► Contract Manufacture
► Licensing
► Foreign Manufacturing Strategies with Direct Investments
► Cooperative Strategies
► Joint Ventures & Strategic Alliances
International Product and Service Management
► Products, Services and Service Marketing
► The Components of the International Product Offer
► Factors Affecting International Product Management
► Standardisation
► Adaptation
► Product Policy
► Product Strategies
► Managing Products across Borders
► Product Life Cycle
► Product Portfolio Analysis
► Image, Branding and Positioning
► New Product Development
International Communications
► The Role of Marketing Communications
► The Fundamental Challenges for International Marketing Communications
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► International Marketing Communications Strategy
► The Marketing Communications Tools
► Person Selling
► Exhibitions and Trade Fairs
► Advertising
► Sales Promotions
► Sponsorships
► Public Relations
The Management of International Distribution and Logistics
► The Challenges in Managing an International Distribution Strategy
► Selecting Foreign Country Market Intermediaries
► Building Relationships in Foreign Market Channels
► Trends in Retailing in International Markets
► Internet Relating
► Globalisation of Retailing
► The Management of the Physical Distribution of Goods
► Use of Intermediaries
► Transportation
Pricing for International Markets
► Domestic versus International Pricing Decisions
► The Factors Affecting International Pricing Decisions
► Developing Pricing Strategies
► Problems of Pricing and Financing International Transactions
► Problems in Multi-national Pricing
► Problems in Managing Foreign Currency Transactions
► Problems in Minimising the Risk of Non-payment in High Risk Countries
► Administrative Problems Resulting from the Cross Border Transfer of Goods
International Marketing Implementation Through Enabling Technologies
► The Enabling Technologies
► The Internet Websites
► E-markets and E-marketing
► International Marketing Solution Integration
► The Impact on International Marketing Strategy
► Moving to a Customer-led Strategy
Learning Outcomes for the Unit:
At the end of this Unit, students will be able to:
1.

Articulate an appreciation of culture’s importance in international marketing.

2.

Discuss how marketing concepts and techniques can/cannot be applied in an international
context.

3.

Identify managerial concerns regarding operating in an international business environment and
address such concerns using relevant concepts.

4.

Evaluate the risks and opportunities associated with operating in an international environment.
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Learning and teaching methods/strategies used to enable the achievement of learning
outcomes:
Learning takes place on a number of levels through lectures, class discussion including problem
review and analysis. Formal lectures provide a foundation of information on which the student builds
through directed learning and self managed learning outside of the class. The students are actively
encouraged to form study groups to discuss course material which fosters a greater depth learning
experience.
Assessment methods which enable the student to demonstrate the learning
outcomes for the Unit:

Weighting:

Examination: 3 hours duration

100%

Indicative Reading for this Unit:
Main Text
International Marketing Strategy - Analysis, Development and Implementation (4th edition), Doole, I.
& Lowe, R., Thompson
Alternative Texts and Further Reading
International Marketing, Paliwoda, S.J. & Thomas, M.J., Butterworth Heinemann
Guideline for Teaching and Learning Time (10 hrs per credit):
50 hours

Lectures / Seminars / Tutorials / Workshops
Tutorial support includes feedback on assignments and may vary by college
according to local needs and wishes.

50 hours

Directed learning:
Advance reading and preparation / Class preparation / Background reading / Group
study / Portfolio / Diary etc.

100 hours

Self managed learning
Working through the course text and completing assignments as required will take up
the bulk of the learning time. In addition students are expected to engage with the
tutor and other students and to undertake further reading using the web and/or
libraries.
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13.1.5 International Trade & Payments I Syllabus

Course Title

International Trade & Payments I

Unit Code

ITP1-0605

Level

4 Diploma

Credits

20

Unit Leader

KE

Pre-requisites
Main Aim(s) of the Unit:
This unit aims to provide a step-by-step guide to the export life cycle, from order to payment and
provides a practical introduction to the fundamentals of import-export procedures. It examines the
financial risks and problems exporters face and develops the necessary skills and knowledge base
for assisting management in the profitable operation of an export business.
Main Topics of Study:
►
►
►
►
►
►
►
►
►
►
►
►
►

International Organisations
Balance of Payments
Delivery Forms
Credit Forms
Exchange Risks
Political Risks
Economic Risks
Remittance Methods
Bills of Exchange
Letters of Credit
Guarantees
Finance of Overseas Trade
Other Trading Methods

Learning Outcomes for the Unit:
At the end of this Unit, students will be able to:
1.

Explain the basis of international trade.

2.

Explain the function of export documentation including financial records.

3.

Describe and contextualise risk factors involved with export.

4.

Describe trading methods for export.

The numbers in the boxes below show which of the above module learning outcomes are
related to particular cognitive and key skills:
Knowledge &
Understanding

Analysis

Synthesis
/Creativity

1-4

-

-

Self-appraisal/
Reflection on
Practice

Planning and
Management of
Learning

Problem Solving

Communication
& Presentation

Other skills
(please specify):

-

1-4

-

1-4

-
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-
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Learning and teaching methods/strategies used to enable the achievement of learning
outcomes:
Learning takes place on a number of levels through lectures, class discussion including problem
review and analysis. Formal lectures provide a foundation of information on which the student builds
through directed learning and self managed learning outside of the class. The students are actively
encouraged to form study groups to discuss course material which fosters a greater depth learning
experience.
Assessment methods which enable the student to demonstrate the learning
outcomes for the Unit:

Weighting:

Examination: 3 hours duration

100%

Indicative Reading for this Unit:
Main Text
Principles of International Trade & Payments, Briggs, P., Blackwell Publishers
Alternative Texts and Further Reading
Export Practice and Management, Branch, Alan E., Thompson
Understanding Documentary Bills and Credits, Dow, Frank, Croner
Multinational Finance, Buckley, A., Prentice Hall
Guideline for Teaching and Learning Time (10 hrs per credit):
50 hours

Lectures / Seminars / Tutorials / Workshops
Tutorial support includes feedback on assignments and may vary by college
according to local needs and wishes.

50 hours

Directed learning
Advance reading and preparation / Class preparation / Background reading / Group
study / Portfolio / Diary etc.

100 hours

Self managed learning
Working through the course text and completing assignments as required will take up
the bulk of the learning time. In addition students are expected to engage with the
tutor and other students and to undertake further reading using the web and/or
libraries.
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13.1.6 Export Practice & Management Syllabus

Course Title

Export Practice & Management

Unit Code

EPM-0605

Level

5 Diploma

Credits

20

Unit Leader

KE

Pre-requisites
Main Aim(s) of the Unit:
This module aims to provide a foundation of knowledge which is key to successful international trade,
including risk, the nature of the global operations industry and its main players, management of
information and record keeping, fundamentals of financial management, record keeping including
balance sheets and P&L accounts as well as cost assessment, managing cash flow and cash flow
forecasting. Price calculation and IT implications and considerations are also covered.
Main Topics of Study:
What an Export Business is All About
► What Does a Business, Any Business, Actually Do?
► What is Management?
► Are There Any Such Things as Management Principles?
► What is Special About an Export Business?
► A Birds-Eye View of What an Export Business Does
► So What is the Point of It All?
Companies & Businesses
► A ‘Business’ or a ‘Company’?
► Types of UK Businesses
► The Significant Characteristics of Incorporated Companies
► National Variations in Financial Reporting
► The Implications of National Variations
How We Measure Our Progress
► ‘It Seems Like a Very Good Idea!’
► Turning a Business Idea into a Business
► What a Financial Management System Does Not Measure
Organising the Information Flows
► Management Information & Control
► Export Activities & Management Records
► Investment in the Market and in the Distributor
► Keeping an Eye on the Profitability
► Keeping an Eye on the Cash
► The Basis of Longer-Term Planning
► The Business as a Machine
Management, the Business & the Finance
► What is a Balance Sheet?
► The Story of a New Exporter
► Bookkeeping Without Any Books
► Some General Points to Consider
► Working Capital
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► The Alternative Layout of a Balance Sheet
The Trading & Profit & Loss Account
► The ‘Accounting Period’
► The Link With the Balance Sheet
► The ‘Accruals Concept’ - This is Important!
► Which Figures Do We Include?
► Which ‘Profit’ Figures Should Management be Interested in?
► What About Accounting for Value Added Tax?
► Calculating the Profit (or loss, as it may be)
► What Does the Profit & Loss (& The Balance Sheet) Tell Us?
How We Calculate the Profit
► How do the Financial Figures Reach Your Desk?
► A Matter of Presentation
► But What Happened to the Cash During the Year?
Thinking About Costs
► Why We Need to Think About Costs Before Doing the Sums
► Why Do We Want to Calculate the Costs Anyway?
► Some Costing Definitions
► Costs for Routine Pricing & Management Control
The Problem with Absorption Costing
► Costs for Strategic Planning & For Tactical Pricing
► The Price Reduction Strategy
► The Sales Promotion Increase Strategy
► The Idea of ‘Contribution’ Towards Fixed Costs
► Accounting for the Costs of Fixed Assets
Cash, & How it Flows In & Out
► A Reminder About ‘Working Capital’
► Which is Important, Profits or Cash?
► The Working Capital Cycle
► Keeping a Grip on Cash Flows
► The Cash Flow Statement
► Analysing & Interpreting the Cash Flow Statement
The ‘Why’ & ‘How’ of Cash Flow Forecasting
► Cash or profit - What’s the Difference?
► Cash, Profits & the ‘Time Value of Money’
► The Essential Features of Cash Flow Forecasting
► A Small Service Company & Its Cash
► The Mill in South East Asia
Cash, Stocks & Working Capital
► A Manufacturing Explosion
► Software & Hardware Bargaining
► The Difference Between Expansion & Just Being Big
► Spreadsheets & Planning
Prices & Costs (& Some Other Things as Well)
► A Problem Involving Pricing & Profits
► Break-Even Volumes
► The Break-Even Chart
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► Using a Computer Spreadsheet
► Using Simple Algebra to Calculate Break-Even Volumes
► Different Ways of Looking at Contribution
► Developing the Idea of Contribution
► Incorporating a Profit Target
► Several Products & Markets
► Optimising the Volumes & Prices
Coping With the Uncertainties
► What do We Mean by Uncertainty or Risk?
► Quantifying Probabilities
► The Contract Problem
► The Successful (?) Distributor Problem, Continued
► The Exhibition Stand Problem Re-Visited
► Selecting a Decision Strategy
► Decision Making in the (Uncertain) Management Context
Information Technology & Exporting
► The Place of Technology in a Business
► System Design
► The System Architecture
► The Operational Requirements
► What Do Users Need to Know of the Technology?
► The Hardware & Software Base
► Software Specifically for the Export Office
► Communications & Wide Area Networks
► Telecommunications, WANs, VANs & EDI
Learning Outcomes for the Unit:
At the end of this Unit, students will be able to:
1.

Explain the nature of international trade and its main players.

2.

Explain the importance of, and some of the processes involved in, good information
management and record keeping.

3.

Demonstrate an understanding of financial management and record keeping including
assessment of balance sheets and profit & loss accounts.

4.

Perform basic calculations in the management of cash flow and cash flow forecasting.

5.

Employ basic algebra to calculate cost and price.

6.

Discuss implications and considerations of IT in the work place.

The numbers in the boxes below show which of the above module learning outcomes are
related to particular cognitive and key skills:
Knowledge &
Understanding

Analysis

Synthesis
/Creativity

Evaluation

Interactive &
Group Skills

1-6

3-6

-

2-6

-

Self-appraisal/
Reflection on
Practice

Planning and
Management of
Learning

Problem Solving

Communication
& Presentation

Other skills
(please specify):

-

1-6

2-6

2-6

-
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Learning and teaching methods/strategies used to enable the achievement of learning
outcomes:
Learning takes place on a number of levels through lectures, class discussion including problem
review and analysis. Formal lectures provide a foundation of information on which the student builds
through directed learning and self managed learning outside of the class. The students are actively
encouraged to form study groups to discuss course material which fosters a greater depth learning
experience.
Assessment methods which enable the student to demonstrate the
learning outcomes for the Unit:

Weighting:

Examination: 3 hours duration

100%

Indicative Reading for this Unit:
Main Text
Principles of Management in Export, Conlan, James, Blackwell Publishers
Alternative Texts and Further Reading
Export Practice and Management, Branch, Alan E., Thompson
The Export Trade, Schmitthoff, Sweet & Maxwell
Guideline for Teaching and Learning Time (10 hrs per credit):
50 hours

Lectures / Seminars / Tutorials / Workshops
Tutorial support includes feedback on assignments and may vary by college
according to local needs and wishes.

50 hours

Directed learning
Advance reading and preparation / Class preparation / Background reading / Group
study / Portfolio / Diary etc.

100 hours

Self managed learning
Working through the course text and completing assignments as required will take up
the bulk of the learning time. In addition students are expected to engage with the
tutor and other students and to undertake further reading using the web and/or
libraries.
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13.1.7 International Marketing Research Syllabus

Course Title

International Marketing Research

Unit Code

IMR-0605

Level

5 Diploma

Credits

20

Unit Leader

KE

Pre-requisites

International Marketing

Main Aim(s) of the Unit:
This unit aims to develop students’ understanding of international approaches to marketing and their
understanding of the research process and its place in an international marketing context.
The unit develops students’ information acquisition competencies and provides the tools and
research skills necessary to solve business problems and exploit business opportunities. It equips
students with an understanding of how to develop export marketing plans and the different
methodologies and techniques available to market researchers.
Main Topics of Study:
Export Markets
► The Nature of Export Markets
► How Many Markets to Choose?
What Influences Market Selection?
► Market Potential
► The Degree of Adaptation Required
► Accessibility of Markets
► Dangers of Fragmentation of Effects
Making the Selection Decision
► Collecting Information & Seeking Advice
► Visiting Markets
► A Strategy for International Marketing
Why is Market Research Needed?
► Market & Investment Planning
► Development of Products to Fit Different Markets
► Choosing the Appropriate Marketing Mix
► Forecasting
Sources of Information
► Internal Records
► External Desk Research
► Field research
Methods of Collecting Information
► Desk Research
► interviews
► Observations
► Test marketing
► Questions & Questionnaires
► Sampling Techniques
The Market Research Brief
► Using In-House Staff
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► Using a Market Research Agency
► Preparing the Brief
Questions & Questionnaires
► The Objectives of the Survey
► The Target Respondent
► Types of Questions
► Forms of Questions
► Pre-Coding Questions
► Editing of Answers
The Export Marketing Plan
► Setting the Objectives
► Resources Required to Meet Objectives
► Sales & Profit Targets to Meet Objectives
Monitoring & Control of the Plan
► Periodic Checks on Performance Against Targets
Numerical & Statistical Analysis
► Presentation of Data by Graph, Chart & Diagram
► Analysis of National World Markets
► Calculating Market Share
► Comparative Performance
Budgets
► Sales Budgets
► Market Research Budget
► Other Types of Budgets
Some Other Numerical & Statistical Aspects
► Use of Averages
Learning Outcomes for the Unit:
At the end of this Unit, students will be able to:
1.

Explain differences and dynamics of international markets and how approaches to international
marketing can be adapted.

2.

Explain the role and process of international marketing.

3.

Explain information acquisition options and demonstrate understanding of the tools and
research skills available to solve international marketing problems.

4.

Draw up a draft export marketing plan.

5.

Discuss the relative merits of different methodologies and techniques available to market
researchers.

The numbers in the boxes below show which of the above module learning outcomes are
related to particular cognitive and key skills:
Knowledge &
Understanding

Analysis

Synthesis
/Creativity

Evaluation

Interactive &
Group Skills

1-5

4,5

4

1,4,5

-

Self-appraisal/
Reflection on
Practice

Planning and
Management of
Learning

Problem Solving

Communication
& Presentation

Other skills
(please specify):

-

1-6

4,5

1-5

-
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Learning and teaching methods/strategies used to enable the achievement of learning
outcomes:
Learning takes place on a number of levels through lectures, class discussion including problem
review and analysis. Formal lectures provide a foundation of information on which the student builds
through directed learning and self managed learning outside of the class. The students are actively
encouraged to form study groups to discuss course material which fosters a greater depth learning
experience.
Assessment methods which enable the student to demonstrate the learning
outcomes for the Unit:

Weighting:

Examination: 3 hours duration

100%

Indicative Reading for this Unit:
Main Text
Principles of International Marketing Research, Groves, L.W.J., Blackwell Publishers
Guideline for Teaching and Learning Time (10 hrs per credit):
50 hours

Lectures / Seminars / Tutorials / Workshops
Tutorial support includes feedback on assignments and may vary by college
according to local needs and wishes.

50 hours

Directed learning
Advance reading and preparation / Class preparation / Background reading / Group
study / Portfolio / Diary etc.

100 hours

Self managed learning
Working through the course text and completing assignments as required will take up
the bulk of the learning time. In addition students are expected to engage with the
tutor and other students and to undertake further reading using the web and/or
libraries.
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13.1.8 International Trade & Payments II Syllabus

Unit Title

International Trade and Payments II

Unit Code

ITP2-0605

Level

5 Diploma

Credits

20

Unit Leader

KE

Pre-requisites

International Trade and Payments I

Main Aim(s) of the Unit:
This unit covers the key areas of international trade and payments and evaluates ways to reduce the
various risks that are common to all international trade. By evaluating individual buyer’s risks, the
student is able to understand the most appropriate and practical methods of payment in trade. It
addresses this technical but vital business topic using a step by step guide approach to the life cycle
of a representative export from initiation through to completion.
Main Topics of Study:
The Rules of the Game
► The Law of Comparative Costs
► How did International Trade Begin?
► The Benefits of International Trade
► The Structure of International Trade
► Economic, Commercial & Political Factors
► Countertrade
► Trading With Eastern Europe
► Multi-national Companies & Direct Investment
► International Organisations Seeking to Facilitate World Trade
► Regional Organisations Seeking Liberalisation
Country & Buyer Risk
► Country Risk
► Balance of Payments
► The International Monetary Fund & the World Bank
► Political Risk
► Buyer Risk
► Credit Insurance
The Quotation
► Delivery Terms
► Calculation of the Quoted Export Price
► Profit Margin, Pricing Policy & Delivery Terms
► Credit Terms
► Foreign Exchange Pricing
Foreign Exchange
► Convertibility of Currencies
► Quoting in Currency
► The Exchange Risk
► Understanding Rates of Exchange
► Forward Exchange Contracts
► Forward Exchange Rates
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► Calculating Forward Exchange Rates
► Closing Out Forward Contracts
► Pure Currency Options
► The Wider Picture
► Avoiding the Spread
► Euro-Currency Markets
► Tender to Contract Cover
Agreeing a Method of Payment
► Risks Associated with the Country or the Buyer
► The Role of the Credit Controller
► Types of Methods of Payment
► Methods of Remittance
Documentary Collections
► The Bill of Exchange
► Uniform Rules for Collection
Documentary Credits - Obtaining the Credit
► The Definition of a Letter of Credit
► Opening a Documentary Credit
► The Main Categories of Documentary Credits
► Types of Documentary Credit
► Documentary Credits as the Exporter Sees Them
Documentary Credits - Securing Payment
► Examination of a Credit on Receipt
► Amending Letters of Credit
► The Doctrine of Strict Compliance
► Discrepancies in Presentations
► The Pre-Presentation Examination
► Action in the Event of Discrepancies
Banker’s Guarantees (Bonds) & Indemnities
► Guarantees Issued by Local Banks
► The Exporter’s Liability to the Bank
► Indemnities Securing the Release of Goods
► Bank Guarantees in Support of Loan or Overdraft Facilities
► Custom Clearance Guarantees
Finance for International Trade
► Bank Finance to Establish Export Markets - Overdrafts & Loans
► Bank Finance from Contract to Payment - Overdrafts & Loans
► Credit Insurance Cover
► Bills of Exchange
► Forfaiting &Factoring
► Other Sources of Finance
► Finance for Imports
Other Trading Methods
► Consignment Trading
► Joint Ventures Overseas
► Pick-A-Back Schemes & Group Selling
► Royalty Agreements & Licensing
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Learning Outcomes for the Unit:
At the end of this Unit, students will be able to:
1.

Use cost data for the planning, monitoring and control of a business.

2.

Recommend, for any market, optimum mixes of trade finance.

3.

Identify and explain country and buyer risks in any export plan.

4.

Discuss methods to avoid trading losses arising from business conducted in foreign currencies.

5.

Critically assess methods of finance in international trade.

6.

Analyse and select appropriate procedures to secure payment for goods or services.

7.

Analyse current issues in international trade, including trade policy, with reference to different
models of international trade.

Learning and teaching methods/strategies used to enable the achievement of learning
outcomes:
Learning takes place on a number of levels through lectures, class discussion including problem
review and analysis. Formal lectures provide a foundation of information on which the student builds
through directed learning and self managed learning outside of the class. The students are actively
encouraged to form study groups to discuss course material which fosters a greater depth learning
experience.
Assessment methods which enable the student to demonstrate the learning
outcomes for the Unit:

Weighting:

Examination: 3 hours duration

100%

Indicative Reading for this Unit:
Main Text
Principles of International Trade & Payments, Briggs, Peter, Blackwell Publishing
Alternative Texts and Further Reading
Trade Finance: Payments & Services, Cox, D.B., Northwick Publishers
Multi-national Finance, Buckley, A., Prentice Hall
Exchange Rates & International Finance, Dufey & Giddy
Guideline for Teaching and Learning Time (10 hrs per credit):
50 hours

Lectures / Seminars / Tutorials / Workshops
Tutorial support includes feedback on assignments and may vary by college
according to local needs and wishes.

50 hours

Directed learning
Advance reading and preparation / Class preparation / Background reading / Group
study / Portfolio / Diary etc.

100 hours

Self managed learning
Working through the course text and completing assignments as required will take up
the bulk of the learning time. In addition students are expected to engage with the
tutor and other students and to undertake further reading using the web and/or
libraries.
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13.1.9 International Trade & Transport Syllabus

Course Title

International Trade & Transport

Unit Code

ITT-0605

Level

5 Diploma

Credits

20

Unit Leader

KE

Pre-requisites
Main Aim(s) of the Unit:
This unit aims to develop the necessary skills and knowledge base to maintain a sound system for
classifying and recording cost accounting information for stock valuation, profit measurement, and for
assisting management in the profitable operation of a business.
Main Topics of Study:
Physical Distribution in Perspective
► Define Marketing
► Domestic Versus Export Markets
► Marketing Research
► Market Selection
► Bad Reasons for Exporting
► Good Reasons for Exporting
► Market Selection Criteria
► Methods of Market Research
► Sources of Secondary Information
► The Marketing Plan
► Indirect Exports
► Direct Sales
► Selection of Distribution Channels
► International Physical Distribution
The Export Office
► The Export Office
► Organisation Charts
► External Organisations
The Export Quotation
► Forms of Export Quotation
► Buyer Documents
► International Delivery Terms
► Trade Terms
Inland Transport
► Packing & Marketing
► Packing Methods
► Factors Affecting Choice of Packing
► Dangerous Goods
► Conclusion
International Transport Modes
► Freight Forwarders

International Trade

46

► The Services of the Forwarder
► Sea Freight Services
► Charter Party
► Types of Sea Freight Services
► Road Freight
► Rail Freight
► Air Freight
► Groupage
► Express Operations
► Selection of Transport Mode
► Carrier Selection
► Freight Calculation
► Total Distribution Cost
International Transport Documentation
► An Overview of Export Documentation
► The Transport Conventions
► The Bill of Lading
► Types of Bills of Lading
► Waybills
► Air Waybill
► Road Waybill
► Rail Waybill
► Sea Waybill
International Customs Controls
► An Overview of Customs Controls
► Export
► Import
► Transit
► The European Community/Union
► Export Procedures
► SAD Summary
► CHIEF
► Export Declarations Summary
► Why Transit Controls?
► Transport Internationaux Routiers
► TIR TABAC Carnets
► Community Transit System
► The Single Market
► Summary
► Community Imports
► Import Controls
► Non-Tariff Barriers
► The Export Invoice
► Customs Management
Risk Management
► Physical Risk
► Credit Risk
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► Exchange Risk
► Cargo (Marine) Insurance
► Principles of Insurance
► Credit Insurance
► Exchange Risk
Methods of Payment
► Choosing Terms & Methods of Payment
► Open Account
► Bills of Exchange (Drafts)
► Documentary Letter of Credit (L/C)
► Documentary Requirements
► Doctrine of Strict Compliance
► Avoiding Rejection
► Types of Letters of Credit
► Cash in Advance or With Order
► Factors
► Countertrade
The Future
► One-Run Systems
► Computer Systems
► Electronic Data Interchange (EDI)
► The Single European Market
► Barrier to Trade
► The Channel Tunnel
Learning Outcomes for the Unit:
At the end of this Unit, students will be able to:
1.

Discuss characteristics of good and bad markets.

2.

Discuss considerations in choice of packaging.

3.

Discuss the function and use of a range of international transport documentation.

4.

Discuss the role and functions of customs controls.

5.

Discuss relative merits of a range of payment methods.

The numbers in the boxes below show which of the above module learning outcomes are
related to particular cognitive and key skills:
Knowledge &
Understanding

Analysis

Synthesis
/Creativity

Evaluation

Interactive &
Group Skills

1-5

-

-

1,2,4,5

-

Self-appraisal/
Reflection on
Practice

Planning and
Management of
Learning

Problem Solving

Communication
& Presentation

Other skills
(please specify):

-

1-5

-

1-5

-
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Learning and teaching methods/strategies used to enable the achievement of learning
outcomes:
Learning takes place on a number of levels through lectures, class discussion including problem
review and analysis. Formal lectures provide a foundation of information on which the student builds
through directed learning and self managed learning outside of the class. The students are actively
encouraged to form study groups to discuss course material which fosters a greater depth learning
experience.
Assessment methods which enable the student to demonstrate the learning
outcomes for the Unit:

Weighting:

Examination: 3 hours duration

100%

Indicative Reading for this Unit:
Main Text
Principles of International Physical Distribution, Sherlock, Jim, Blackwell Publishing
Alternative Texts and Further Reading
Economic Geography, Robinson, H., Pitman
Understanding the Freight Business, Downs, D.E., Micor
Export Practice & Management, Branch, Alan, Thomson Business Press
Guideline for Teaching and Learning Time (10 hrs per credit):
50 hours

Lectures / Seminars / Tutorials / Workshops
Tutorial support includes feedback on assignments and may vary by college
according to local needs and wishes.

50 hours

Directed learning
Advance reading and preparation / Class preparation / Background reading / Group
study / Portfolio / Diary etc.

100 hours

Self managed learning
Working through the course text and completing assignments as required will take up
the bulk of the learning time. In addition students are expected to engage with the
tutor and other students and to undertake further reading using the web and/or
libraries.
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13.1.10 The International Business Environment Syllabus

Unit Title

The International Business Environment

Unit Code

IBE-0605

Level

5 Diploma

Credits

20

Unit Leader

KE

Pre-requisites
Main Aim(s) of the Unit:
This course seeks to provide an understanding of the complex and dynamic nature of corporate
environment in today’s globalised economy in which the business and its external environment are
not clearly separated.
One of the most important functions of management is decision making and in order to perform
effectively managers need to be informed.
Students must therefore be familiar with, and aware of, all major international political, economic,
cultural, religious and financial issues of the day.
Political, economic and financial events in one country can create threats, as well as opportunities for
other countries and it is essential that managers are able to relate international events, and their
consequences, to their own business environments.
Students are required to critically analyse current topics concerning important management and
policy issues facing business and industry. Critical evaluations of current readings from business
literature will be used as assessment items.
At each examination series reference will be made to six contemporary issues which have made
international news headlines in the four months preceding the examinations. Candidates will be
asked to select any three of the issues or topics and comment on them.
This is a self-paced, self-study course and motivated self-starters will enjoy this format.
Main Topics of Study:
Self study - See above
► Corporate environment in the global economy
► Current issues in business including political, economic, cultural, religious and financial
aspects
► Business and the impact of international current affairs
Learning Outcomes for the Unit:
At the end of this Unit, students will be able to:
1.

Discuss current issues management and its policy implications.

2.

Understand current issues and trends from a managerial perspective.

3.

Integrate current business scholarly literature in their arguments.

4.

Provide analytical perspectives of current problems and trends.

5.

Demonstrate a proactive rather than reactive approach to management.
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Learning and teaching methods/strategies used to enable the achievement of learning
outcomes:
This is a self-paced, self-study course that is suited to motivated self-starters. Learning can take
place on a number of levels through lectures and class discussion, including problem review and
analysis. However, this is not specifically designed for formal lectures.
Contemporary readings provide the foundation of information on which the student builds through
critical analysis of articles outside of the class. The students are actively encouraged to form study
groups to discuss course material which fosters a greater depth learning experience.
Assessment methods which enable the student to demonstrate the learning
outcomes for the Unit:

Weighting:

Examination: 3 hours duration

100%

Indicative Reading for this Unit:
Main Text
The Economist
Additional Source of Information
CNN News
Guideline for Teaching and Learning Time (10 hrs per credit):
0 hours

Lectures / Seminars / Tutorials / Workshops
Tutorial support includes feedback on assignments and may vary by college according
to local needs and wishes.

100 hours

Directed learning
Advance reading and preparation / Class preparation / Background reading / Group
study / Portfolio / Diary etc.

100 hours

Self managed learning
Working through the course text and completing assignments as required will take up
the bulk of the learning time. In addition students are expected to engage with the tutor
and other students and to undertake further reading using the web and/or libraries.
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